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Preface

Revision History

Description of

Part Number Revision Date Changes

4426481 A New Document for
Version 1.2 Software:
Improvements to allelic
ladder algorithm

How to Use This Guide

Purpose of This
Guide

Audience

Assumptions

Text Conventions

The GeneMapper®™ ID-X Software Version 1.2 Reference Guide:
* Provides reference information on sizing and genotyping.

+ Describes the GeneMapper® ID-X Software quality value
system and peak quality values (PQVs).

This guide is intended for GeneMapper /D-X Software users who
review and evaluate sizing and genotyping data.

This guide assumes that you are familiar with analyzing data using
the GeneMapper® ID-X Software.

This guide uses the following conventions:
* Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

 [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.
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User Attention
Words

Send Us Your
Comments

* A right arrow bracket ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All.

Two user attention words appear in Applied Biosystems user
documentation. Each word implies a particular level of observation
or action as described below:

Note: Provides information that may be of interest or help but is not
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

Examples of the user attention words appear below:

Note: The size of the column affects the run time.

Note: The Calibrate function is also available in the Control
Console.

IMPORTANT! To verify your client connection to the database, you
need a valid Oracle user ID and password.

IMPORTANT! You must create a separate Sample Entry Spreadsheet
for each 96-well plate.

Applied Biosystems welcomes your comments and suggestions for
improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Preface
How to Obtain Support

How to Obtain Support

For HID support, you can send an e-mail to
HIDTechSupport@appliedbiosystems.com or call 888-821-4443
option 1.

For HID support outside North America, contact your local support
office.

For the latest services and support information for all locations, go to
http://www.appliedbiosystems.com, then click Support. At the
Support page, you can:

* Access worldwide telephone and fax numbers to contact
Applied Biosystems Technical Support and Sales facilities.

» Search through frequently asked questions (FAQs).
* Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs,
certificates of analysis, and other related documents.

* Download PDF documents.
* Obtain information about customer training.

* Download software updates and patches.
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Chapter 1

n Peak Detection, Sizing, Allelic
Ladder, and Sample Analysis §
Algorithms

This chapter covers:

B Allelic Ladder Requirements. . .. ..................... 2
B Overview of the Peak Detection, Sizing, and Genotyping
Process. ... .. 4
B Peak Detection. ........... ... oo, 4
B SiZIng. ... 16
B Allelic Ladder Genotyping ... ...................... 26
B Sample Genotyping. . ...........oiviirirennnnn.. 34
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Allelic Ladder Requirements

Allelic Ladder Requirements

Allelic Ladder Run  To accurately genotype samples, you must use an Allelic Ladder
Requirements sample that has been run with the samples. For samples that are run
on an:

+ ABI PrisM® 310 Genetic Analyzer — Run at least one allelic
ladder for every 10 sample injections.

+ ABI PrisM® 3100 or Applied Biosystems 3130 series Genetic
Analyzers — Run at least one allelic ladder for every set of 16
samples.

— 3130x/ or 3100 Genetic Analyzers — One ladder per injection
(one injection = 16 samples)

— 3130 or 3100-Avant Genetic Analyzers — One ladder for
every four injections (one injection = 4 samples)

IMPORTANT! Variation in laboratory temperature can cause changes
in fragment migration speed that can, in turn, cause sizing variation.
Applied Biosystems recommends the frequency of allelic ladder
injections described above to account for normal variation in
fragment migration speed. However, during internal validation
studies, verify the required allelic ladder injection frequency to
ensure accurate genotyping of all samples in your laboratory
environment.

It is critical to genotype using an allelic ladder that is run under the
same conditions as the samples because:

* Size values that are obtained for the same sample can differ
between instrument platforms because of different polymer
matrices and electrophoretic conditions.

» Slight procedural and reagent variations between single and
multiple capillaries result in greater size variation than that
found between samples injected in the same capillary in a single
run.

2 GeneMapper® ID-X Software Version 1.2 Reference Guide



Chapter 1 Peak Detection, Sizing, Allelic Ladder, and Sample Analysis Algorithms n
Allelic Ladder Requirements

Allelic Ladder + To accurately genotype samples, the GeneMapper® ID-X
Analysis Software requires at least one allelic ladder sample per run
Requirements folder.

IMPORTANT! If a run folder contains multiple allelic ladder
samples, the GeneMapper /D-X Software calculates bin offsets
using an average of all ladders that use the same panel within a
run folder (for more information, see “Bin Offsetting” on

page 27).

+ Allelic ladder samples must be identified as “Allelic Ladder” in
the Sample Type column in a project.

* Analyze the allelic ladder sample(s) using the same analysis
method and parameters used for samples.

GeneMapper® ID-X Software Version 1.2 Reference Guide 3
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Overview of the Peak Detection, Sizing, and Genotyping Process

Overview of the Peak Detection, Sizing, and
Genotyping Process

Peak Detection™:
e Baseline Window Size
¢ Smoothing

¢ Polynomial Degree and

Peak Window Size

e Slope Threshold Peak
Start and End

Allelic Ladder Genotyping:
e Allele matching

¢ Allelic ladder quality
assessment

¢ Bin offsetting

Sizing™:
e Size matching

e Size-calling curve
generation

e Size calling
e Sizing quality
assessment

Sample Genotyping:
e Allele calling and
filtering

e Genotype and sample
quality assessment

*Sample peak detection and sizing is performed after allelic ladder genotyping.

Peak Detection

Peak Detection:

detected.

Parameters in the Analysis Method Peak Detector tab determine how
the raw data are baselined and smoothed, and how peaks are

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Examining Peak
Definitions

Peak Detection
Analysis Method Editar ==
| General | allle || Peak Detector | peak quality | 5Q & GQ Settings |
Peak Detection Algorithm: Advanced
Ranges Peak Detection
Analysis . Sizing ) Peak Amplitude Thresholds:
.FuII Range - Al Sizes - | B |so R |50
Start PE:|O Skart Size:|0
. ;|50 - |50
Stop PE: | 10000 Stop Size: 1000 G P
y. |50 Q; |50
Smoothing and Baselining
Min, Peak Half Width: |2 pts
Smoothing (71 None
_ i 8 3
© Light Palynomial Degree
() Heavy Peak Window Size: 15 pts
Baseline Window: 51 pts St ireslinlt]
Peak Start: 0.0
~3ize Calling Method Peak End: 0n
() 2nd Order Least Squares
() 3rd Order Least Squares Mormalization

(7 Cubic Spline Interpolation
(@ Local Southern Method
() Global Southern Method

Use Mormalization, if applicable

Factory Defaults

[ Save H Cancel H Help ]

This section describes how these parameters work. For more
information on these parameters, see the GeneMapper® ID-X
Software Help.

IMPORTANT! This section provides examples of the effect of
changing certain peak detection parameters. Applied Biosystems
provides default settings in the software, but your laboratory should
verify these settings, or changes to these settings, as part of your
laboratory’s internal validation studies.

To examine how GeneMapper® ID-X Software has defined a peak,
select Plot » Peak Positions in the Samples plot window. The peak
positions (start, apex, end) are tick-marked in the electropherogram.

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Peak Detection

Baseline Window Size

Peak Detection:

e Baseline
Window Size

Guideline for
Using This
Parameter

Effects of Varying
Baseline Window
Size

The Baseline Window size parameter controls baselining for a group
of peaks.

The software determines a reference baseline value for each data
point. In general, the software sets the reference baseline to be the
lowest value that it detects in a specified window size (in data points)
centered on each data point.

A small baseline window relative to the width of a cluster, or
grouping of peaks spatially close to each other, can result in shorter
peak heights.

Larger baseline windows relative to the peaks being detected can
create an elevated baseline, resulting in peaks that are elevated or not
resolved to the baseline.

The default setting of 51 is optimal for analysis of AmpF{STR® kit
data.

Choose a value that encompasses the width in data points of the
peaks being detected while preserving a qualitatively smooth
baseline.

The trade-off for a smoother baseline that touches all peaks is a
reduction in peak height.

Figure 1 on page 7 shows a sample with different reference baselines
(zero in the analyzed electropherogram) that result from different
baseline window size settings:

* The red trace shows a baseline derived from an extreme baseline
window size value of 2801. At this setting, the reference baseline
does not touch all peaks and elevates peak heights.

» The blue trace shows a baseline derived from the default value of
51 data points.

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Peak Detection

* The black trace shows a baseline that is derived from an extreme
baseline window size value of 5 data points. At this setting, the
reference baseline tracks the peaks, significantly reducing peak
height.

1200 T T

1000 - B
800 - B

600 - B

L

]

—

‘U_lmmllJ. ‘”Ml i, MMMMMM. |

0 500 1000 1500 2000 2500 3000

Figure 1 Baseline Window example
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Peak Detection

Smoothing

This parameter smooths the outline of peaks, and reduces the number

Peak Detection: of false peaks that are detected.

Smoothing is performed before peak detection and can be set to:
e Smoothing

Option Description

None Applies no smoothing. Select for slower runs with very
broad peaks, or to avoid the detection of sharp edges.

Light Provides the best results for typical data. Light smoothing
slightly reduces peak height.

Heavy Select for data with very sharp, narrow peaks of interest.
Heavy smoothing can significantly reduce peak height.

Figure 2 shows the effect of smoothing settings on a peak.

ao00 a0z6 anso an76

—— No smoothing (black)

—— Light smoothing (green)

_ Heavy smoothing (red)

Figure 2 Smoothing example

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Polynomial Degree and Peak Window Size

Peak Detection:

e Polynomial
Degree and
Peak Window
Size

Effects of Varying
the Polynomial
Degree

Peak Detection

Polynomial Degree and Peak Window Size settings affect the peak
detection sensitivity. You can adjust these parameters to detect a
single base pair difference while minimizing the detection of
shoulder effects and/or noise.

The peak window size functions with the polynomial degree to set
the sensitivity of peak detection. The peak detector calculates the
first derivative of a polynomial curve fitted to the data within a
window that is centered on each data point in the analysis range.

Using curves with larger polynomial degree values allows the curve
to more closely approximate the signal and, therefore, the peak
detector captures more of the peak structure in the electropherogram.

The peak window size sets the width (in data points) of the window
to which the polynomial curve is fitted to data:

* Higher peak window size values smooth out the polynomial
curve, which limits the structure being detected.

» Smaller window size values capture more of the peak structure.

How to Use the Peak Detection Parameters

Use the table below to adjust the sensitivity of detection.

Function Polynomial Degree Window Size
Value Value
Increase sensitivity Higher Lower
Decrease sensitivity Lower Higher

Figure 3 on page 10 shows peaks detected with a window size of 15
data points and a polynomial curve of degree 2 (green), 3 (red), and 4
(black). The diamonds represent a detected peak using the respective
polynomial curves.

Note that the smaller trailing peak is not detected using a degree of 2
(green). As the peak detection window is applied to each data point
across the displayed region, a polynomial curve of degree 2 could not
be fitted to the underlying data to detect its structure.

GeneMapper® ID-X Software Version 1.2 Reference Guide 9
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Peak Detection

Effects of
Increasing the
Window Size
Value

2000

Polynomial curve of degree 4
1500 (black)

Polynomial curve of degree 3
(red)

1000 -
Polynomial curve of degree 2\

(green)

500

Figure 3 Electropherogram showing peaks detected with three
different polynomial degrees

In Figure 4 on page 11 both polynomial curves have a degree of 3
and the window size value was increased from 15 (red) to 31(black)
data points.

As the cubic polynomial is stretched to fit the data in the larger
window size, the polynomial curve becomes smoother. Note that the
structure of the smaller trailing peak is no longer detected as a
distinct peak from the adjacent larger peak to the right.

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Peak Detection

2000 —

1500 —

Window size value of 31 (black)

T Window size value of 15 (red

500

Figure 4 Electropherogram showing the same peaks as in
Figure 3 after increasing the window size value but keeping the
polynomial degree the same

Optimizing Peak Detection Sensitivity - Example 1:
Reducing Peak Window Size

Figure 5 on page 12 shows the initial electropherogram with two
resolved alleles of known fragment lengths (they differ by one
nucleotide) that are detected as a single peak. The analysis was
performed using a polynomial degree of 3 and a peak window size of
19 data points.

Peak Detection:

¢ Polynomial
Degree and
Peak Window
Size

GeneMapper® ID-X Software Version 1.2 Reference Guide 11
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Peak Detection

Effects of

Reducing Window

12

Size

440 4150 1D 4170 4130 4100 SN0 4210 410 420 440 450 4G VD 4200 4D 4300 4300 4320 40 4D 00 G0 AOFD 430 00 0D 41D 4l

2500 |

2250 |

2000 |

1 |

1500 |

1260 |

1000 |

0 |

Figure 5 Electropherogram showing two resolved alleles
detected as a single peak

Figure 6 shows that both alleles are detected after reanalyzing with
the polynomial degree set to 3 and the window size value decreased
to 15 (from 19) data points.

4140 4150 1D 4170 4130 4190 400 4200 420 430 R0 450 A0 LF0 460 4M0 K00 S0 420 400 040 B K0 L0 A0 HA0 HOD M0 M0

2500 |

2250 |

2000 |

e |

1500 |

1220 |

1000 |

Figure 6 Electropherogram showing the alleles detected as two
peaks after decreasing the window size value

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Peak Detection

Optimizing Peak Detection Sensitivity - Example 2:
Extreme Settings

Figure 7 shows the result of an analysis using a peak window size
value set to 10 and a polynomial degree set to 9. These extreme
settings for peak detection caused several peaks to be split and
detected as two separate peaks.

Peak Detection:

¢ Polynomial
Degree and
Peak Window '
Size

010 A0 400 44D A0S0 0ED 70 ADSD DD 4100 4110 4120 410 4140 4150 4180 470 4180 4100 40 4210 220 220

om0 |

0 |

w0 |

hyl
t

Figure 7 Electropherogram showing the result of an analysis
using extreme setting for peak detection

Slope Thresholds for Peak Start/End Parameters

The Slope Threshold for Peak Start and Slope Threshold for Peak
Peak Detection: End parameters adjust the start and end points of a peak.

The values assigned to these parameters can be used to better
position the start and end points of an asymmetrical peak, or a poorly

e Polynomial resolved shouldering peak to more accurately reflect the peak

Degree and Peak position and area.
Window Size . .

« Slope Threshold In geperal, from left to right, the slope of a peak 1ncrease.s from the
Peak Start and baseline up to the apex. From the apex down to the baseline, the
Peak End slope decreases negatively until it returns to zero at the baseline

(Figure 8 on page 14).

GeneMapper® ID-X Software Version 1.2 Reference Guide 13
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Peak Detection

J  \

Baseline - - - - - - _~—__ _______ >

Increasingly
positive slope

Increasingly
negative slope

0

Figure 8 Peak slope

If either of the slope values you enter exceeds the slope of the peak
being detected, the software overrides your value and reverts to zero.

Guidelines for * For typical or symmetrical peaks, use a value of zero.
Using These + For asymmetrical peaks, select values other than zero to better
Parameters reflect the beginning and end points.

* A value of zero does not affect the sizing accuracy or precision
of an asymmetrical peak.

Using These Note: The size of a detected peak is the calculated apex between the
Parameters start and end points of a peak. Peak size does not change based on
start and end settings.

To move the... Then... Example
Start point of a Change the Slope Threshold for Peak
peak closer to its Start value from zero to a positive
apex number.

End point of apeak | Change the Slope Threshold for Peak
closer to its apex End value to a more negative
number.

14 GeneMapper® ID-X Software Version 1.2 Reference Guide



Chapter 1 Peak Detection, Sizing, Allelic Ladder, and Sample Analysis Algorithms n

Slope Threshold Example — Asymmetrical Peak

Peak Detection:

e Baseline Window
e Smoothing

e Polynomial

Degree and Peak
Window Size

¢ Slope Threshold

Peak Start and
Peak End

Adjusting Slope
Threshold for
Peak End

Peak Detection

Initial Electropherogram

Figure 9 shows the initial electropherogram analyzed with value of
0 for Peak Start and Peak End. Note the asymmetrical peak with a
noticeable tail on the right side.

B0 2130 F0 218D 2160 2070 260 R0 200 0 Zb 20 ;40 ;AN me0 M0 mAD D80 20D B0 B

1600 | I

o0 |

an

0 |

1

Figure 9 Electropherogram showing an asymmetrical peak

After reanalysis with a value of —35.0 for the Slope Threshold for
Peak End, the end point that defines the peak moves closer to its
apex, thereby removing the tail (Figure 10). Note that the only
change to tabular data is the area (peak size and height are
unchanged).

B0 2130 Z0 218D 260 2170 280 R0 200 0 Zb 20 ;40 ;AN me0 M0 mAD D80 200 B0 B

o0 |

an

0 |

Figure 10 Electropherogram showing the effect of changing the
slope threshold for peak end

GeneMapper® ID-X Software Version 1.2 Reference Guide 15
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Sizing

Sizing

During sizing, the software:

Sizing:
e Size matching * Performs size matching of the internal size standard in all
e Size-calling samples against the size standard definition selected in the
curve generation software.
* Size calling » Generates a size-calling curve.
e Sizing quality .
assessment * Sizes DNA sample peaks.

+ Assesses the sizing quality.

Size Matching

During size matching, the software matches the size standard
fragments from the electropherogram to the list of fragment sizes in
the size standard definition specified in the software.

Sizing:
¢ Size matching
e Size-calling

curve generation Size matching uses ratio matching, based on relative height and
* Size calling distance of neighboring peaks. It then derives quality values
¢ giszsiggscrt*:rii:y statistically by examining the similarity between the theoretical
(from the size standard definition) and actual (observed) fragment
patterns.

The software ignores anomalous peaks that do not match the
expected patterns. The software constructs a best-fit curve using the
data points of each size standard fragment detected. A comparison
between the sizes calculated from the best-fit curve and the matched
peaks from the size standard definition file using the array of
numbers is performed. Size-matching (and subsequent size calling)
fails if significant differences in peak patterns are found, if no match
can be made based on the expected patterns, or if all peaks are not
found.

Because the software uses ratio-matching (looks for the expected
number of alleles and expected peak patterns instead of specific data
points), it is not necessary to define new size-standard definitions
due to migration shifts.

Figure 11 on page 17 illustrates the size matching and size-calling
curve generation algorithm.

16 GeneMapper® ID-X Software Version 1.2 Reference Guide
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Sizing

Determines the expected peak spacing and height ratios
Uses the list of sizes from the Size Standard definition file.
Note: The values that are used are for example only and do not indicate typical size-standard values.

Base 400
pair

50 100 200

J |

Evaluates peaks in the size standard data
Ignores peaks that do not meet expected pattern (dotted peak).

Base
pair

Base
pair 50 100 200 400 200 400

less than X 2x 4x
4x

Data
point

100 200

400

800

Data

point 800

100 200 400

Plots the Size-calling curve
Uses peaks that meet expected pattern

500 —

400 — v

Base pair
n w
o o
o o
| |
o

100 o7

O 71 T T T T T
0 100 200 300 400 500 600 700 800 900

Data point

Figure 11 Size matching and size-calling curve generation
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Sizing

Size-Calling Curve Generation and Size Calling

Sizing:

e Size matching

e Size-calling
curve
generation

¢ Size calling
e Sizing quality

18

To generate the size-calling curve, the software plots the actual data
points of the size standard against the expected size of each size
standard peak. The size-calling method determines how the
size-calling curve is generated and used to size each sample.

During size matching and size calling:
» Two size-calling curves are generated for each sample:

— Black: A best-fit second order curve, regardless of the
size-calling method that is selected.

— Red: A curve based on the size-calling method that is
selected in the analysis method.

» The data points of non-size-standard peaks are plotted against
the size-calling curve

* Peaks are sized according to the size-calling method that is
selected in the analysis method

Size-calling methods are:

» Local Southern

* Global Southern

» Least Squares (2nd Order or 3rd Order)
+ Cubic Spline Interpolation

(¥ Size Match Editor x|
File Edit View Tools

*xHE|

Size Matches  Size Calling Curve

ID_Meq_crtrl fsa
ID_Sampled.fsa Best Fit Second Order Curve

D_Sarnplzd.fsa FOOT 0125 3428510775434

ID_Samples fsa AI=0.06EEAZES1281970461
ID_Control. fsa A2=1.273205747726376268

400
o0 Lacder fsa Reg=D 8968937481
I_Neg_crirl fsa
ID_Sampled.fsa
ID_Sampled.fsa
IDr_Samples fsa 00

200

100
size Calling Curve

Local Southem hiethor

3000 000 5000 6000 7000

oK Cancel Apply
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Size Calling — Local Southern Method

Sizing:

e Size matching

e Size-calling
curve generation

¢ Size calling

e Sizing quality
assessment

Local Southern
Method Equation

Sizing

The Local Southern method (Figure 12) determines the sizes of
fragments by using the reciprocal relationship between fragment
length and mobility, as described by E. M. Southern (1979).

T
Basl Fii Segond Sroer Sunve
00 ADE-125 5516T5T0444131
A =0, 0EET e KSR s0E50
AZ=1 FEERGEO01SES4 ZES
500 Fir=0. Sz a0 T SeREE
B
kL
2
1 Liza Calling Cunea
Loal Souliven Matnoo
1] + + + + + + + + + + + + + + + + + +
L1} 1000 il 1] EoLL ) L) S (oLl ] T S0 0

Figure 12 Local Southern method

IMPORTANT! Do not use the Local Southern size-calling method for
AmpF(STR® MiniFiler™ PCR Amplification Kit data. The Local
Southern method requires two data points below the smallest
fragment for accurate sizing. Because of the small size of amplicons
generated using the MiniFiler™ kit, the GeneScan""500 LIZ® Size
Standard 50 bp peak may be hidden by the primer peak, and allele 5
in the D16S539 marker can size at <75 bp. Use the 3rd Order Least
Squares size-calling method described on page 22.

The equation attempts to describe the reciprocal relationship
between the mobility, m, and the length, L0, of the standard
fragments.

L = [c¢/(m — m0)] + L0
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How The Local This method, which is similar to the Cubic Spline method (page 24),
Southern Method uses the four fragments closest in size to the unknown fragment to
Works determine a best-fit line value. Only the region of the size standard
near the fragment of unknown length is analyzed.

Note: Size estimates may be inaccurate if any of the standard
fragments run anomalously.

In the Local Southern method (Figure 13):

1. The fitting constants of the curve are calculated for each group
of three neighboring points on the standard.

2. A curve is then created using three standard points (two points
below and one point above the fragment), then a fragment size
is determined.

3. Another curve is created using an additional set of three points
(one point below and two points above the fragment), to assign
another value.

4. The two curves are averaged to determine the unknown
fragment length.

i

i 8§ i

Size Calling Cures

Losal Souler Methoc

1000 2000 3000 4000 S000 G000 TOOD SO0 D000

To size call fragments between b and c:
e Fit curve through a, b, and ¢

e Fit curve through b, c, and d

* Average curves between b and ¢

Figure 13 Local Southern method
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Sizing

Size Calling — Global Southern Method

The Global Southern method (Figure 14) is similar to the Least
Squares method (page 22) in that it compensates for standard
fragments that may run anomalously. The method creates a best-fit
line through all the available points, and then uses values on that line
to calculate the fragment values.

Sizing:

e Size matching

e Size-calling
curve generation

¢ Size calling

e Sizing quality
assessment

500 Bes1 Pl Second Sroer Cunve

ACE-1 25542851 1 0TT 5454
A1 =0.0BEEGAG4 B GT0451
400 P=] ZTIZIETATTZRSTEZES
Firz=0) SR0aasT 41 252058

Eize Calling Curve

Slcial Soutiher Matmoo

2700 300 300 30 4300 4700 G100 G500 SO G300 V00 T100  TH00

Figure 14 Global Southern method

Global Southern

Method Equation Description
Equations Attempts to describe the reciprocal
relationship between the mobility, m,
L = [e/(m-m0)]+ L0 and the length, LO, of the standard
fragments.

5 The fitting constants LO, m0, and ¢
Zi{Lz’— [¢/((mi—mO0)+ LO)]} are calculated by a least-squares fit
to minimize the left side quantity.

How the Global All points in the standard are weighted equally, and the curve is not
Southern Method constrained to go through any specific point. The software can
Works analyze a large range of fragment sizes with this method. For best
results, use a standard that brackets all the fragments of interest.
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Sizing

Size Calling — Least Squares Method

Sizing:

e Size matching

e Size-calling
curve generation

¢ Size calling

e Sizing quality
assessment

Using 3rd Order
for MiniFiler™ Kit
Data

Examples

22

Both Least Squares methods (2nd-Order and 3rd-Order) use
regression analysis to build a best-fit size-calling curve. This curve:

¢ Produces the minimum additive distance from the curve to the
plotted data points.

* Compensates for any fragments that may run anomalously.

Consequently, this method typically results in the least amount of
deviation for all the fragments, including the size standards and the
samples.

Depending on whether you choose the 2nd- or 3rd-Order Least
Squares Method in the Analysis Parameters dialog box, the resulting
size curve is either a quadratic or a cubic function. The software uses
the known standard fragments and the associated data points to
produce a sizing curve based on Multiple Linear Regression.

A 3rd-order curve (which uses a higher polynomial degree and
captures more of the peak structure) provides the most flexibility
when generating best-fit curves for sizing samples with anomalously
migrating fragments.

Figure 15 on page 23 and Figure 16 on page 24 show that in nearly
all instances the mobility of an individual DNA fragment is
coincident with the best curve fit of the entire data set. Stated
differently, the mobility of most DNA fragments is strictly length
dependent. This method automatically compensates for fragments
that run anomalously.

To generate the Least Squares curve, the software:
* Plots the known fragment sizes (bp) versus data points.
* Generates a best-fit curve using regression analysis.
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» Applies the following calculation to determine the size in data
points of the unknown fragments:

Y =Ax>+Bx?*+Cx+D
where:

Y = size (bp)

x = datapoint

A = First order coefficient

B = Second order coefficient
C = Third order coefficient
D = Zeroth Coefficient or constant

500 4 Beai Fil Seaond Dncer Surve

ACE-1Z5, 342851 100 T 545
) 4 A1 =00055E0854 1 2157045
AZ=1 ZTIEIETATT2ESTEZES
RrE=0 SR T4e

Lize Calling Curea
Leaa] Sojuare Seaoid Dok

1] -ttt 4+ttt 4+t
2700 300 JO00 0 430 4700 S0 S0 o500 6300 GA00 7100 To00

Figure 15 2nd-Order Least Squares size-calling curve
(quadratic)
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Figure 16 3rd-Order Least Squares size-calling curve (cubic)

Size Calling — Cubic Spline Interpolation Method

The Cubic Spline method (Figure 17), which is similar to the Local
Southern method (page 19), forces the sizing curve through all the
known points of the selected size standard. Although this
enforcement produces exact results for the values of the standards
themselves, it does not compensate for standard fragments that may
run anomalously.

Sizing:

e Size matching

e Size-calling
curve generation

¢ Size calling

e Sizing quality
assessment

=] Bzl Fii Saconc Sroer Cure

A= 24 G Sl B0 0T
A1=0.05TOSSEA2ETER 48
=1, EBEEMES BREEEEE E-G
Fire=0.09eeaeee T4 522

Liza Calling Sures

Cuioe Spline nlerolaiicn

¢ +—+——tt—+——t—+—+—+—t+—+—+—+—+—+—+—+—+—+—+—+—+
2700 3100 3500 00 A3 4700 S0 5500 S0 G300 6700 TI0D TS0

Figure 17 Cubic Spline Interpolation method
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Possible Local
Sizing Inaccuracy

Sizing

Mobility of any DNA fragment can be affected by its sequence, and
by secondary and tertiary structure formation. If any internal size
standard fragment has anomalous mobility, the Cubic Spline method
may exhibit local sizing inaccuracy.

For example, assume that a standard fragment is close in molecular
length to an unknown sample fragment. Assume further that the
standard fragment runs anomalously. The Cubic Spline method
assigns the official value to this standard fragment, even though it
may be slightly incorrect. The size of the unknown fragment is then
likely to be calculated incorrectly as well.

Note: This method does not determine the degree of sizing accuracy
error.

Sizing Quality Assessment

Sizing:

e Size matching

e Size-calling
curve generation

e Size calling

¢ Sizing quality
assessment

The last step in sizing is the sizing quality assessment. Sizing quality
is discussed in “Sizing Quality Assessment” on page 43.

The software does not genotype samples with @ sizing quality.
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Allelic Ladder Genotyping

Allelic ladde
genotyping:

quality
assessme

e Allele matching
e Allelic ladder

e Bin offsetti

After sizing quality is determined, the following occur:
r

+ Allele matching
* Allelic ladder quality assessment

* Bin offsetting
nt

ing

Allele Matching

During allele matching, the software assigns allele labels to allelic

ggﬁ&,lg%%?r ladder peaks by matching peaks with the bins that are specified in the
e Allele matching panel. The matching algorithm uses ratio-matching, based on relative
e Allelic ladder distance and height of neighboring peaks.
lit . . .
gggelsément Figure 18 is an example of the blue dye plot in the AmpF(STR®
« Bin offsetting Identifiler® PCR Amplification Kit allelic ladder.

K Markers specified in panel with color-coded headers that reflect Genotype Quality (GQ result)\

Expected

' LLILEL[L[L ' E'lx-lm_l_ﬁ?ll?ﬁ-l-lnl"lll T 1 3 l 1 llﬁla

Peaks detected for each marker in the allelic ladder with allele assignments based on
expected peak patterns

bins specified in panel (gray or pink indicators under each marker)

/

26

Figure 18 Identifiler® kit allelic ladder blue dye
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Allelic Ladder Quality Assessment

After allele matching, allelic ladders are evaluated to determine

Allelic ladder whether they are used to create bin offsets, described on page 27.
genotyping:
* Allele matching Allelic ladder quality assessment is discussed in “Allelic Ladder
* Allelic ladder Quality Assessment” on page 45.

quality

assessment

¢ Bin offsetting

Bin Offsetting

Bin offsetting evaluates the alleles found in allelic ladder samples
and adjusts bins before allele-calling. Marker ranges are also
adjusted based on the bin offsets.

Allelic ladder
genotyping:

e Allele matching
e Allelic ladder

quality AmpF(STR® Allelic Ladder and Bin Sets
assessment . ® 1 )
« Bin offsetting The allelic ladder for each AmpF{STR™ kit contains the most

common alleles for each locus and is used to generate the reference
sizes in the bin sets provided with the software.
Reference sizes consider:

* The actual size (bp) of DNA fragments.

* 3" A nucleotide addition.

* Mobility shifts related to the non-nucleotide linkers in the
allelic ladder. Non-nucleotide linkers enable reproducible
positioning of the alleles to facilitate inter-locus spacing.
(Grossman et al., 1994 and Baron et al., 1996)
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Physical and Virtual Bins

The bin set provides reference allele sizes for:

 Alleles physically present in the allelic ladder (physical bins).

» Alleles that are not present in the allelic ladder (virtual bins),
but have either been reported in STRbase
(www.cstl.nist.gov/div83 1/strbase) or discovered during
developmental validation of a particular chemistry at Applied

Biosystems, and can be genotyped by reference to the alleles
present in the ladder.

Figure 19 illustrates a bin set with eight physical bins and six virtual
bins.

[D351358

il 100 110 120

400

Virtual
Virtual
Virtual
Virtual
Virtual
Virtual

a00

Peaks that fall within virtual bins are
not present in the allelic ladder

N
| 1

Physical bins at allelic ladder peak locations

Figure 19 Bin set with physical and virtual bins

Note: The GeneMapper® ID-X Software allows you to display

virtual bins in pink. For information, see the GeneMapper® ID-X
Software Help.
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How the Software When analyzing allelic ladder samples, the GeneMapper® ID-X
Calculates and  Software offsets the reference sizes defined in the bin set relative to
Applies Bin the actual sizes obtained for the alleles in the allelic ladder.

Offsets

To determine offsets, the software:

1.

Allelic Ladder Genotyping

Performs an allelic ladder quality assessment (described on
page 45).

Uses [ CGQ allelic ladders with [ SQ only.
CGQ is described on page 54. SQ is described on page 43.

Identifies the size of a physical allele in the allelic ladder.
Virtual alleles are not used to calculate offsets.

If more than one allelic ladder sample is present in the run
folder, determines the offset for each allele in each of the allelic
ladder samples, then averages the offsets for the allele.

Offsets the corresponding bins for the physical alleles by the
difference between the observed size for the allele in the run
data and the reference size for the allele.

Offsets the virtual bins. To offset the virtual bins, the software
uses the offset from the closest physical bin or virtual bin to the
left of the bin in question. If the first bin is a virtual bin, the
software uses the offset from the first physical bin (counting
from left to right).
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Example: One
Allelic Ladder Is
Present In a Run

Folder

30

6. Offsets the:

* Marker Range Min Size value by the calculated bin offset
of the first physical bin of the allelic ladder in the marker.

* Marker Range Max Size value by the calculated bin offset
of the last physical bin of the allelic ladder in the marker.

For more information, see “Displaying Offset Marker Margins”
on page 33.

IMPORTANT! The software displays the reference marker
range in two places: in the Samples plot status bar when you
click the marker header above the plot and in the Panel
Manager. To display the offset marker ranges, examine the value
that is displayed in the Samples plot status bar when you click
the red marker indicators on the x-axis of the Samples plot.

7. Repeats the process for each physical allele in all samples with a
Sample Type of Allelic Ladder.

A reference size in the bin set for an allele is 122 bp. The observed
size is 119.56 bp. The offset value is calculated as

119.56 — 122 = —-2.44. The bin for this allele is shifted down 2.44
base pairs to 119.56 (£ 0.5 bp).

Figure 20 on page 31 shows the reference size (bin) for allele 14 in
the D3S1358 marker before analysis.
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Reference allele size (position of the bin) 122 + 0.5 bp

Figure 20 Bin assignment before offsetting

Figure 21 on page 32 shows that after analysis of the allelic ladder
sample, the bin is offset based on the observed size of the allele in
the allelic ladder.
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Fe Edt Yew Iools Aleles Help

e | o=
[ | TS| | 8
e

|rm.1 ‘sqn ‘su

ID_Ladder fsa ‘ldmtiﬁls_vl ‘ []

[D3S1358

el

[ ) 5
[X 119566 ¥ 7] [Peak: Deﬁa‘\m 3367 Size 119,56 Height 169 A’\e 14] [Bin: 14 Marker D351358]

Offset bin 119 £ 0.5 bp

Figure 21 Bin assignment after offsetting

Example: More A reference size in the bin set for an allele is 122 bp. The observed
Than One Allelic  size is 119.56 bp for one allelic ladder sample and 119.50 bp for
Ladder Sample Is  another allelic ladder sample. The offset for the each allelic ladder

Present In a Run sample is calculated (119.56 — 122 = -2.44) and
Folder (119.50 — 122 =-2.50). The software averages the two offsets
[(-2.44 + -2.50)/2 =—-2.47]. The bin for this allele is shifted down
2.47 base pairs to 119.53 (£ 0.5 bp).

Example: How Virtual allele 11 in Figure 21 above uses the same offset value as
Offsets Are allele 12. The sizes between these two alleles differ by 4 bp.
Applied To Virtual Specifying a size for allele 11 that is 4 bp shorter than allele 12 is a
Alleles reasonable estimate because alleles 11 and 12 differ by a single

repeat unit (4 bp).
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Displaying Offset When bins are offset, marker margins are also offset. To display the
Marker Margins  shifted marker margins, click the red marker indicators in the
Samples plot (Figure 22).

Satple File |5mpleNm |m
|m_5mpmrm |Sa‘mp]a’l |I.
[DestiiTe  |DRIST
120
* . MJ Click the red tick mark at
’ M mm . Marker start to display
u - the offset marker start in
5 the status bar
Kl

(11311 vz2])

Figure 22 Displaying offset marker margins

Note: Reference marker margins that are defined in the panel are
displayed when you click the marker header in the Samples plot and
in the Panel Manager (Figure 23).

sl |s ple Hame E;]PanelManager
ID_Samples fsa |s,,,mm File Edit Bins Yiew Help

G | B | W | Bin et [AmeRLSTR Bins 1 I

]
o 40 a0 120
E T =] [Urrseal [Dbker Hame  Tye Eolar \ im M iz Cons
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LTI Rl 7> 1511 Rlie R4S P47.5 an

Original marker margins
(not shifted)

&

o \

[E]
(=]

K
Kl

[ 154.65 ¥ 4‘@[Mark&r: DBS51179 (118.00-183.50)]

A

Figure 23 Original marker margins are displayed when you click
the marker header in the Samples plot and in the Panel Manager
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Sample Genotyping

After allelic ladders are detected and sized, sizing quality is

Sample genotyping: determined, then allelic ladders are genotyped.

e Allele calling and

filtering After allelic ladders are genotyped, samples are detected and sized,
* Genotype and sizing quality is determined, then samples are genotyped.

sample and

quality During genotyping of samples, the GeneMapper® ID-X Software:

assessment

* Performs allele-calling and filtering.
* Assesses genotype quality.
» Assesses sample quality.

Allele Calling and Filtering of Samples

During allele calling of samples, the software:

Sample genotyping: .

e Allele calling * Labels allele peaks in unknown samples:
and filtering — Compares sizes of the unknown peaks to the offset bins.

: Saenr;ggp;engnd — Assigns the relevant allele label if a peak falls within one of
quality the defined bins. Figure 24 on page 35 is an example of a 14
assessment allele in D3S1358.

— Assigns an OL (Off-Ladder) label if a peak falls outside of
the defined bins.
» Applies filters to eliminate peaks from consideration as allele
peaks:

— Allele Tab analysis method settings (Global Cut-off value,
Minus A, Global Stutter, Amelogenin Cutoff, and Range
Filter)

— Marker-specific stutter ratios if specified in the Analysis
Method (Allele tab) and defined in the panel
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Off Ladder (OL)
Allele Calls

Allele Naming
Convention

Sample Genotyping

Fil View Tooks Aleles Help
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00] [Peak: Data Point 3461 Size 119.730Height 743 Allsle 14] [Bir: 14 Marker D3S1358]

Reference allele size (position of the bin) 119 + 0.5 bp

Figure 24 Allele calling

Notice the size of this allele is 119.73, which is within the shifted bin
calculated previously (119.53 + 0.5 bp, see Figure 21 on page 32).
Therefore, this peak is labeled as a 14.

If a peak falls outside one of the defined bins, the software labels it
OL (Off Ladder).
OL calls may be caused by:

» The presence of a microvariant allele at a particular locus
* Sample migration anomalies and artifacts

Allele names are assigned based on the number of complete
four-base-pair repeat-units and partial repeat-units:

» Complete four base pair repeat units are designated by an
integer.

* Variant alleles that contain a partial repeat are designated by a
decimal followed by the number of bases in the partial repeat.
For example:
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— An FGA 26.2 allele contains 26 complete repeat units and a
partial repeat unit of two base pairs.

— A D21S11 allele 33.1 contains 33 complete repeat units and
one nonconsensus base pair.

— A D21S11 29.3 allele contains 29 complete repeat units and a
partial 3-bp unit (Moller et al., 1995; Gill et al., 1997).

Genotype and Sample Quality Assessment

To determine sample quality, the software:

Sample genotyping:

e Allele calling and » Applies user-defined and software-defined thresholds to
filtering generate marker-level quality value flags (described in “Marker-

* Genotype and Level Quality Assessment” on page 47) and sample-level
53’:“2;;9 and quality value flags (described in “Sample-Level Quality
gssessment Assessments” on page 53).

* Applies GQ weighting from ,* marker-level quality value flags
to determine the Genotype quality (GQ) (described in “Sample-
Level Quality Assessments” on page 53).

» Uses GQ to determine the sample-level CGQ composite
genotyping quality assessment (described in “CGQ (samples)”
on page 54).
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Overview of the Quality Value System

The GeneMapper® ID-X Software provides a quality value system
and a set of streamlined data review tools and features that can be
optimized and validated for use in both expert systems and
traditional data analysis workflows.

The GeneMapper® ID-X Software quality value system:

» Assesses the quality of allelic ladders before analysis and does
not consider low-quality allelic ladders for genotyping.

» Assesses the quality of data at the sample and marker level
using process quality values (PQVs).

* Can be used in an optimized and validated expert system or
traditional data analysis workflow to quickly identify data
quality issues and aid in interpretation of samples that do not
meet all thresholds.

* Can be used in an optimized and validated expert system
workflow to quickly segregate samples that require manual
review from those that do not.

The PQV results of the quality assessment are displayed as
color-coded flags: [ ;. @. The color of the flag depends on
software-specified thresholds or user-defined thresholds set in the
analysis method.

Optimizing and  Before using any software as an expert system, optimize and validate
Validating an  the thresholds for each AmpF{(STR kit and instrument platform
Expert System combination by processing a variety of samples that challenge each
of the quality flags.

IMPORTANT! Different kit/instrument combinations may require
different thresholds.
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Displaying By default, the GeneMapper /D-X Software displays Pass [,

Numeric SQ and  Check- %, or Low Quality @) for Sizing Quality (SQ) and

GQ Values Genotyping Quality (GQ) to represent the numeric score of the

assessment.

For example, the Sizing Quality (SQ) yields a value between 1 and 0.
Based on the SQ threshold settings of the SQ & GQ Settings tab, the
software displays Pass ], Check- *,, or Low Quality @) to indicate

the SQ result.

You can alternatively display numeric values for SQ and GQ.

Sizing Quality Representation

Samples Table Example

Symbols RunMame  |SFNF |SNF |03 (GQ) | WELLG
(default) DoE_SWPex | (M (W (W] W
peEswrex [ (W (W \m) [m
Numbers RunMame |SFMF |SMF |05 (5Q) |WELLG
DGE_EWPE_ ([ @ @ [T 1o
DGE_SHPI 10f [10
SheeC il (W (1Y

To display numeric values for SQ and GQ:

1. Select File » Project Options, then select the Analysis tab.

2. In the Quality Metrics Display settings, select Numbers.

Quality Metrics Display —

(%) Symbals

() Numbers

3. Click OK to apply the settings.
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Overview of the Quality Value System Checks and Assessments

Overview of the Quality Value System Checks and

Assessments

40

The GeneMapper ID-X Software quality value system performs the
following checks and assessments:

* Analysis requirements checks:

Before analysis starts, identifies any conditions that may
prevent analysis or cause unexpected results. If one or more
analysis requirements are not met, the ARNM (Analysis
Requirements Not Met) PQV is set to . If Project Options
are set accordingly, the Analysis Requirements Summary is
also displayed (described in GeneMapper® ID-X Software
Help).

* Allelic ladder genotyping:
— Sizing quality assessment — Evaluates the quality of the size

standard profile in each allelic ladder.

Allelic ladder quality assessment — Evaluates allelic ladder
quality. Also determines if an allelic ladder is used for
creating bin offsets. If the software finds one or more allelic
ladders that do not meet sizing and genotyping requirements
and Project Options are set accordingly, the Allelic Ladder
Analysis Summary is displayed (described in GeneMapper®
ID-X Software Help).

Marker-level quality assessment — Evaluates labeled peaks
within each marker. The SPK and OS PQVs contribute to the
allelic ladder GQ assessment if spikes and/or off-scale
fluorescence signals are present in the allelic ladder (and
Spike Detection is Enabled for the Allelic Ladder and the
Allelic Ladder GQ Weighting for Spikes and Off-scale is set
to 1[on]. If Spike Detection is Disabled for the Allelic
Ladder, spikes will not be detected or labeled.) Other PQVs
do not affect allelic ladder GQ.

Sample-level quality assessment — Evaluates the quality of
the entire sample.

* Sample genotyping:
— Sizing quality assessment — Evaluates the quality of the size

standard profile in each sample.
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Analysis Requirement Checks

— Marker-level quality assessment — Evaluates labeled peaks
within each marker. Contributes to the genotype quality

assessment.

— Sample-level quality assessment — Evaluates the quality of

the entire sample.

* Genotype quality assessment — Evaluates the quality of each
marker in a sample. Contributes to the overall composite

genotype quality assessment.

Analysis Requirement Checks

The analysis requirements checks are performed before data analysis
starts. If one or more analysis requirement checks is ;*, analysis
may not occur or may not give the expected results (for example,
analyzing without a size standard or allelic ladder affects sizing

quality or genotyping quality).

Analysis requirements checks that are displayed in the Samples table before the analysis

starts
Acronym Full Name Function/Rule(s) Flag
SFNF Sample File Indicates if the software finds the Sample file found
Not Found sample (.fsa or .hid) files in the original
location from which they were added to Sample file not
the project. found
Select Edit » Define New Sample File
Path to re-associate the samples file
with the project.
MNF Matrix Not Indicates if the software finds in the Matrix file found
Found database the matrix file that is
associated with the sample. Matrix file not found
SNF Size Standard | Indicates if the software finds in the Size standard
Not Found database the size standard definition definition found

associated with the sample.

Size standard
definition not found

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Note: The SFNF, MNE, and SNF flags are included in the ARNM
flag described on page 42. To conserve space, display only the
ARNM column in the Samples table.

Analysis requirements checks that are displayed in the Analysis Requirements Summary
after the analysis starts

Acronym Full Name Function/Rule(s) Flag Indicator

ARNM Analysis Indicates if all analysis requirements are d All analysis
Requirement met. These requirement checks are requirements are
Not Met performed when analysis is started, met.

before actual analysis begins:

e Sample File Not Found g):ataiycnsl'ismore
¢ Analysis Method Not Selected requirements are not
e Analysis Method Not Found In The met.

Database
e Panel Not Selected
e Panel Not Found in the Database
¢ Binset Not Selected

¢ Binset In Analysis Method does not
match Binset selected in the Panel
Manager

e Size Standard Not Selected

e Size Standard Not Found In
Database

e Size Standard Dye Color Is Not
Present In The Sample Dye Set

e Matrix Not Selected

e Matrix Not Found or Contains Invalid
Data

¢ No Allelic Ladder Selected In Run
Folder

¢ GMID V3.x Analysis Method Selected

¢ Basic Or Classic Size Standard
Selected

e SNP Panel Selected

Note: The ARNM PQV includes the

SFNF, MNF, and SNF PQVs described

on the previous page. To conserve

space, display only the ARNM column in
the Samples table.
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Sizing Quality Assessment

The quality value system evaluates the quality of the size standard
profile within each sample (SQ) and allows you to flag size
standards with poor peak resolution. You can adjust the ranges that

correspond to the Pass ||, Check

.» and Low Quality @) ranges in

the analysis method (SQ & GQ Settings).
Sizing Quality that is displayed in the Samples Table after the analysis is complete

Acronym Full Name Function/Rule(s) Flag Indicator
SQ Sizing Evaluates the similarity between the [ | sQis within the
Quality fragment pattern for the size standard user-defined Passing

dye that is specified in the size standard
definition and the actual distribution of
size standard peaks in the sample,
calculates an interim SQ (a value
between 0 and 1) as described in
“Sizing” on page 16, then applies the
broad peak weighting that is specified in
the analysis method.

Weighting

The Broad Peak (BD) threshold and SQ
Broad Peak weighting that is specified
in the analysis method affect the SQ. To
determine the final SQ value, the
software:

e FEvaluates peak widths in the sample
in the dye color specified in the size
standard definition.

¢ |f the width of any peak in the sizing
range exceeds the broad peak
threshold, applies the SQ weighting:

Interim SQ x (1 — SQ weighting)

GeneMapper® ID-X Software Version 1.2 Reference Guide

range
(Default = 0.75 to 1.0)

SQ is between the
user-defined Passing
range and Low Quality
range

(Default = 0.26 to
0.74)

SQ is within the
user-defined Low
Quality range

(Default = 0.0 to 0.25)
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Sizing Quality that is displayed in the Samples Table after the analysis is complete

Acronym Full Name Function/Rule(s) Flag Indicator

SQ SIZIng Example
(continued) | Quality )
A size standard peak exceeds BD

threshold, has an Interim SQ = 0.8, and
SQ weighting = 0.5. The final SQ is:

SQ=0.8x(1-0.5)=04
Based on the default SQ range, this SQ
is

Note: Broad Peak (BD) threshold and
SQ Broad Peak weighting are
user-defined.

Note: The GeneMapper® ID-X
Software does not genotype samples
with @ SQ.
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Allelic Ladder Quality Assessment

The quality value system performs an allelic ladder quality
assessment to determine if a ladder is used in genotyping (to create
bin offsets, described on page 27).

Allelic ladder quality is reported per marker by the GQ (Genotyping
Quality is described on page 51) and per sample by the CGQ
(Genotyping Quality is described on page 54).

Quality Rules  Allelic ladder samples are analyzed before all other samples. An
allelic ladder sample must have a [ SQ and a ] CGQ to be used
for creating bin offsets. For an allelic ladder to have a ] CGQ), all
the markers within the allelic ladder must pass the following rules:

Rule Description
1 All ladder alleles specified in the panel used to analyze are detected.
2 In each marker, the peak height ratio of the first and second peak is greater than 50%.
This rule eliminates allelic ladders if the stutter peak before the first true allele peak is labeled
as an allele.
3 No spikes are detected above 20% (default) of the highest allele peak in the same dye color

within the extended marker range.

Note: When spike detection is enabled for Allelic Ladders, spike detection is performed
within each extended marker range (no gaps are present between markers; the end point of
each marker is extended past the marker definition in the panel to the beginning of the next
marker).

Note: When spike detection for allelic ladders is set to Disable, spikes will not be detected
or labeled.

Note: The Allelic Ladder Spike Cut-off value is user-definable in the Peak Quality tab of the
analysis method.

4 The peak height ratio between the lowest and highest peak is equal to or greater than 15%.

5 In each marker, the base pair spacing between any two ladder alleles specified in the panel
used to analyze is within the expected range.

6 No off-scale (OS) fluorescent signal is detected within each extended marker range.
Note: The Allelic Ladder GQ Weighting for Off-scale is user-definable.
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Effect on GQ

Allelic ladder quality rules are evaluated at the marker level and
affect GQ results.

If any of the rules do not pass, the GQ (described on page 51) for the
allelic ladder marker is set to @.

Note: If rule 3 does not pass and the Allelic Ladder GQ Weighting
for Spikes is set to 0 (off in the SQ & GQ Settings tab in the analysis
method), the GQ for the allelic ladder marker is set to ], even if
spikes are present.

Other than SPK, no other individual marker-level PQV flags
(described on page 47) affect the GQ of allelic ladder samples.
Therefore, they do not affect the allelic ladders used for genotyping.
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Marker-Level Quality Assessment

Marker-level quality assessment indicates the quality of each marker
in a sample.

Marker-level quality assessment evaluates only labeled peaks within
a defined marker size range defined in the panel and can be weighted
to contribute to the calculation of the GQ (Genotype Quality).

Note: Gray PQVs ([ &) indicate that at least one label in the
marker was edited or the GQ was overridden.

Marker-level quality flags that are displayed in the Genotypes table after the analysis is

complete
Acronym Full Name Function/Rule(s) Flag Indicator
oS Off-scale Indicates if any fluorescence signal No fluorescence
exceeds the detection threshold of the signal exceeds the
instrument. detection limit of the
Note: The detection limit varies on instrument.
different instruments. The OS quality
flag indicates if the CCD camera is f?unoer’gécrgr?gz signals
saturated at any data point within the exceed the
analysis range. It is not based on an detection limit of the
absolute RFU value (peak height). instrument.
BIN Out of Bin Indicates if labeled peaks do not fall No labeled peaks
Allele inside bins. These peaks are labeled are detected outside
with OL (off ladder). For information of an offset bin.
bin offsetting, see page 27.
One or more labeled
peaks are detected
outside an offset
bin.

GeneMapper® ID-X Software Version 1.2 Reference Guide
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Marker-level quality flags that are displayed in the Genotypes table after the analysis is
complete (continued)

Acronym Full Name Function/Rule(s) Flag Indicator
PHR Peak Height Indicates if the peak height ratio A The peak height
Ratio between the lowest and highest peak is ratio calculated
less than the Min Peak Height Ratio between the lowest
defined in the analysis method. and highest peaks is

equal to or greater
than the Min Peak
Height Ratio
threshold.

The peak height
ratio calculated
between the lowest
and highest peaks is
less than the Min
Peak Height Ratio

threshold.
N/A | Only one peak is
labeled.
MPH Max Peak Indicates if any peak heights (RFU) d No peaks exceed
Height exceed the Max Peak Height (RFU) the Max Peak
value set in the analysis method. Height (RFU) value

(all peak heights are
less than or equal to
the threshold).

One or more peaks
exceed the Max
Peak Height (RFU)
value.

N/A | No peaks are
detected or all
peaks are off-scale

(OS).
LPH Low Peak Indicates if any peak heights (RFU) are d All detected peak
Height below the following thresholds set in the heights are equal to

analysis method: or greater than the

¢ Homozygous Min Peak Height thresholds.

e Heterozygous Min Peak Height One or more peak
heights are below
the thresholds.

48 GeneMapper® ID-X Software Version 1.2 Reference Guide



Chapter 2 GeneMapper® ID-X Software Quality Value System m
Marker-Level Quality Assessment

Marker-level quality flags that are displayed in the Genotypes table after the analysis is
complete (continued)

Acronym Full Name Function/Rule(s) Flag Indicator
AN Allele Number | Indicates if the software detects: d At least one allele
and not more than
e No alleles
or the Max Expected
Alleles are detected
¢ More than the Max Expected Alleles or X allele for
set in the analysis method (Peak Amelogenin is
Quality tab) detected.
or
 No X allele in Amelogenin No alleles, more
than the Max
Expected Alleles, or
no X allele for
Amelogenin is
detected.

BD Broad Peak Indicates if the width of any peak d No peaks exceed
exceeds the Max Peak Width (half the Max Peak Width
height in basepairs) defined in the threshold.
analysis method (Peak Quality tab).

k
Broad peaks may be a result of dye S)?ceeggj Thoer?\/lr;ia s
artifacts or poor resolution. Peaks with Peak Width
poor resolution: threshold
e May be caused by electrophoresis
issues
¢ May not be true DNA peaks
CC Control Indicates if a positive, custom, or d Positive or Custom
Concordance negative control produces the expected Control - Expected

profile.

The expected profile is obtained from:

¢ Positive Control — The Control Alleles
in the panel used for analysis.

e Custom Control — The profile
associated with the Profile ID in the
Profile Manager.

¢ Negative Control — No peaks
expected.

Applies only to Sample Type = Positive
Control or Negative Control.

Weighting of the CC PQV is
non-editable and set to 1.0.

N/A

profile is detected.

Negative Control -
No peaks are
detected.

Positive or Custom
Control — Expected
profile is not
detected.

Negative Control -
Peaks are detected.

Sample Type =
Sample or Allelic
Ladder
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Marker-level quality flags that are displayed in the Genotypes table after the analysis is
complete (continued)

Acronym Full Name Function/Rule(s) Flag Indicator
SPK Spike ¢ Allelic Ladders — Indicates if spikes d No spikes are
are detected within each extended detected within the
marker range (no gaps are present range.
between markers; the end point of
each marker is extended past the One or more spikes
marker definition in the panel to the are detected within
beginning of the next marker). the range.

e Samples - Indicates if spikes are
detected within a marker size range.

The software uses a proprietary
algorithm that detects spikes based on
the peak morphology.

OVL Overlapping Indicates if a labeled peak (allele or [ | Nolabeled peaks
Alleles artifact) is within the size ranges of two are detected within
neighboring markers. overlapping marker
size ranges.

Applies only if you modify the default
marker size ranges to overlap one

One or more labeled
another.

peaks are detected
within overlapping
marker size ranges.
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Genotype Quality Assessment

For samples, the quality value system assigns the genotype quality
(GQ) for each marker based on the individual marker quality flags.

For allelic ladders, the quality value system assigns a GQ for each
marker based on the allelic ladder quality requirements, as described
in “Allelic Ladder Quality Assessment” on page 45.

The GQ is used to determine the CGQ.

For samples, you can adjust the ranges that correspond to the Pass

[, Check
(SQ & GQ Settings).

, and Low Quality @ ranges in the analysis method

Genotype Quality that is displayed in the Genotypes Table after the analysis is

complete

Acronym | Full Name

GQ ' Genotype
(samples) | Quality

Function/Rule(s)

Indicates the genotype quality of the marker in the

sample. The genotype quality for a sample marker
is determined based on the presence of labeled
peaks detected (after filtering) and the GQ
weighting specified in the analysis method (SQ &
GQ Settings tab):

e If no labeled peaks are detected (and the
sample is not a negative control), the GQ is set
to 0.

e |f one or more labeled peaks are detected, the
GQ is initially set to 1 with a final value
determined by the GQ weighting of individual
marker-level quality values as specified in the
analysis method using the formula:

GQ =1 X[(1 -weight of flag 1) X (1 — weight
of flag 2) X (1 — weight of flag n)]
where:

weight of flag 1 through weight of flag n
represent the GQ weight for the following
PQVs (applied only if the PQV is ;% ): OS,
BIN, PHR, LPH, AN, BD, CC, SPK, and OVL.

GeneMapper® ID-X Software Version 1.2 Reference Guide

Flag Indicator

[ | GQis within the

Passing range

(Default = 0.75 to
1.0)

GQ is between the
Passing range and
Low Quality range

(Default = 0.26 to
0.74)

'GQ is within the

Low Quality range

(Default = 0.0 to
0.25)

or the SQ for the
sample is @).
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Genotype Quality that is displayed in the Genotypes Table after the analysis is
complete (continued)

Acronym | Full Name Function/Rule(s) Flag Indicator

(continued) 832&3"36 Weighting

(samples) The weighting of individual flags affects the GQ.
The CC weight is defined by the software at a
value of 1.0.1f CC is /%, GQ is set to 0 ( {@). Al
other PQVs apply user-defined weights:

e 1:1f a PQV is triggered, it sets the GQ value to

e >0 <1:If a PQV is triggered, it reduces the GQ
value according to the formula on the previous
page. The higher the value, the greater the
effect on GQ.

¢ 0: No effect on the GQ calculation.

Example

A marker contains a LPH and OS flag, all
other flags are [Jl]. The GQ weight for LPH and
OS are set to 0.3.

GQ=1X[1-0.3)X(1-0.3)]

GQ=1X0.49

GQ=0.49

GQ Genotype | Indicates the genotype quality of the marker in the d All allelic ladder
(allelic Quality allelic ladder. The genotype quality for an allelic quality

ladder marker is determined using system-defined requirements are
ladders) . : .

quality rules (described on page 45) to ensure: met.

¢ All expected peaks are present. O One or more allelic
* Peak height ratio of the first and second peak ladder quality
is greater than 50%. requirements are

* No spikes are present in the extended marker not met
range (within or between markers). or the SQ for the

¢ The peak height ratio between the lowest and sample is .
highest peak is equal to or greater than 15%.

IMPORTANT! If the Allelic Ladder GQ Weighting
for Spikes is set to 0 (off) (SQ & GQ Settings tab in
the analysis method), the GQ may be d even if
spikes are present in the allelic ladder.
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Sample-Level Quality Assessments

Sample-level quality assessment indicates the quality of the entire
sample. Samples are grouped in the Analysis Summary based on the
status of sample-level PQVs.

Note: Gray PQVs ([ # O) indicate that a marker in the sample
was edited.

Sample-Level Quality Flags that are displayed in the Samples Table after the analysis
is complete

Acronym Full Name Function/Rule(s) Flag
SOS Sample Indicates if any fluorescence signal d No fluorescence
Off-scale within the analysis range exceeds the signal within the
detection threshold of the instrument. analysis range

exceeds the

Note: The detection limit varies on detection limit of the

different instruments. The OS quality

flag indicates if the CCD camera is instrument.
saturated at any data point within the One ofr more
analysis range. It is not based on an fluorescence signals

absolute RFU value (peak height). within the analysis

range exceed the
detection limit of the

instrument.
MIX Mixed Source | Indicates a potential mixed source d Neither condition is
sample. A sample is considered a met.
potential mixture if it meets either of the
following conditions: _ Either or both

conditions are met,

e Condition 1: Two or more markers potential mixture.

contain three or more called alleles

or N/A | Sample Type =
¢ Condition 2: Allelic Ladder

— One or more markers contain
three or more called alleles
and

— Another two or more markers
have ,* PHR (peak height ratio,
described on page 48)
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Sample-Level Quality Flags that are displayed in the Samples Table after the analysis
is complete (continued)

Acronym Full Name Function/Rule(s) Flag
OMR Qutside Indicates if labeled peaks are detected No labeled peaks
Marker Range | between two marker size ranges defined are detected
in the panel. Does not indicate if labeled between marker size
peaks are detected before the first ranges.
marker or after the last marker.
Note: The default marker size ranges One or more labeled
§ ahbori Kers d | peaks are detected
or neighboring markers do not overlap, between marker size
but microvariants can fall between two ranges
marker size ranges. )
SSPK Sample Spike | ¢ Allelic Ladders - Indicates if spikes No spikes are
are detected within the sizing range. detected within the
¢ Samples - Indicates if spikes are range.
detected within or between two o ik
defined marker size ranges. Does not ne dof[ mtorg SP;h?S
indicate if spikes are detected before ﬁ:e etected within
the first marker or after the last € range.
marker.
The software uses a proprietary
algorithm that detects spikes based on
the peak morphology.
caGQ Composite Overall sample genotype quality All individual marker
(samples) | Genotype indicator. Considers the individual GQ values are .
Quality marker GQ (Genotype Quality) values.
One or more
individual marker
GQ values are
One or more
individual marker
GQ values are @.
Manually overridden
(see the
GeneMapper® ID-X
Software Help for
information).
54 GeneMapper® ID-X Software Version 1.2 Reference Guide




Chapter 2 GeneMapper® ID-X Software Quality Value System m
Sample-Level Quality Assessments

Sample-Level Quality Flags that are displayed in the Samples Table after the analysis
is complete (continued)

Acronym Full Name Function/Rule(s) Flag

caGaQ Composite Allelic ladder quality indicator. Considers | ] | All allelic ladder

(allelic Genotype the allelic ladder quality assessment quality requirements

ladders) Quality (see page 45). Other than SPK, does not are met for every
consider individual marker GQ marker.

(Genotype Quiality) values.

Note: Allelic ladder samples with
CGQ are not used to create bin offsets.
For more information, see page 27.

@ | One or more allelic
ladder quality
requirements are not
met for one or more

IMPORTANT! If the Allelic Ladder GQ markers.

Weighting for Spikes is set to 0 (off), or )
spike detection for the allelic ladder is #» | Manually overridden
disabled (SQ & GQ Settings tab in the (see the

analysis method), the CGQ may be [, GeneMapper® ID-X
even if spikes are present in the allelic Software Help for
ladder. information).
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Appendix A

Troubleshooting

Complete the following form before contacting Applied Biosystems
Technical Support.

Software Issues

Does the computer and operating system meet the required computer specifications?
List any potential discrepancies.

Problem description:

Did you receive any error messages or alerts? If so, what did they say (if possible, take screen
captures)? At what point did these errors/alerts occur?

Is the problem reproducible?
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Steps taken prior to encountering or to reproduce the problem:
1.
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